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1. Introduction to Kernel for Excel 

Welcome to the user manual for Kernel for Excel, the most effective and convenient .xls file repair tool 
available that repairs corrupt MS Excel worksheets. This user manual comprises step by step guidelines on 
using Kernel for Excel. 

1.1  Using this Manual 

This user manual is intended to guide users on using Kernel for Excel. We suggest that first time users 
should read this user manual completely and carefully before proceeding to use the software. However, if 
you are an experienced user, you can use the table of contents to find out information pertaining to the 
tasks that you need to perform by using Kernel for Excel. 

You can use the table of contents to navigate through different sections of this user manual. The table of 
contents lists all the sections that are contained in this user manual in chronological order. The user 
manual comprises the following sections: 

 Introduction 

 Getting Started 

 Software Interface 

 Repairing .XLS Files 

 Full Version 

 Support 

 Troubleshooting 

 Legal Notices 

Certain abbreviations have been used throughout this manual. For clear understanding of the contents of 
this user manual, please go through the list of abbreviations, mentioned below, before reading the manual. 

1.1.1 List of Abbreviations 

MS: Microsoft 

RAM: Random Access Memory 

MB: Mega-Byte 

GB: Giga-Byte 

XLS: Excel Sheet 
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1.2  About Kernel for Excel 

Kernel for Excel is file repair and data recovery software for MS Excel worksheets or spreadsheets. This 
software repairs MS Excel worksheets that become inaccessible due to unexpected system shutdown, 
power failure, virus attacks, media errors, software crash etc. 

Kernel for Excel offers two repairing modes: Single file and Multi file mode. These two modes are provided 
to ease the repairing process. Single mode enables repairing of single file at a time whereas multi file 
mode enables the user to repair batch of corrupt .xls files in one cycle. 

You might be familiar with the following error messages if you have encountered MS Excel worksheet file 
corruption before: 

 "Cannot access read-only document???.xls" 
 "???.xls; File format is not valid" 
 "access denied" 
 "excel cannot open file" 

Kernel for Excel quickly and effectively resolves the above mentioned errors by repairing corrupt .XLS 
keeping the complete document format intact. It restores formatting, Unicode character, headers, footers, 
hyperlinks, OLE objects, data structures, formulas and other existing component of the corrupt MS Excel 
worksheet. 

1.3 Salient Features 

Salient features of Kernel for Excel include: 

 Efficient embedded repair algorithms to quickly repair even heavy files 

 Support for almost all version of MS Excel 

 User friendly graphical user interface 

 Embedded with two beneficial options: Single file and Multi File 

 Supports Unicode in file content and file name 

 Uses Live Preview technology to view the recovered data from the corrupt .XLS file before saving 

 Support for batch repair of .xls files 

 Free demo to analyze features and functions of the tool before purchasing it 

1.4 Who Should Use this Software? 

The capability of Kernel for Excel to repair large sized .xls files makes it appropriate for use by 
professional authors who keep their important data stored in MS Excel worksheets. The capability of the 
software to repair multiple .xls files in one cycle finds its wide application in organizations where batch of 
corrupt .xls files needs to be repaired in one cycle. 
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It is also useful for home users, who have lost their important data stored in .xls files due to .xls file 
corruption. This corruption could have been caused due to virus attacks, improper system shutdown, 
installation of unsupported software, etc. 
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2. Getting Started 

Now that you have understood the features and potential of Kernel for Excel, you are ready to get hands 
on experience of the software. To start repairing .xls files, you will first need to download and install this 
software. However it is strongly recommended that before installing Kernel for Excel, you should go 
through the installation pre-requisites for the software to ensure that your computer is appropriately 
configured to run the software. 

2.1 Installation Pre-requisites 

The various pre-requisites for installing and running Kernel for Excel can be broadly classified into two 
major categories – Hardware requirements and Software requirements. 

2.1.1 Hardware Requirements: 

The hardware requirements for installing the software are as follows: 

 Pentium Class Processor 

 Minimum 64MB RAM (128 MB recommended) 

 10MB for Software installation 

 Disk Space - Enough space to store the repaired files 

 You should have at-least 10 MB of free disk space if you want to repair and save 
a 10 MB.xls file. 

2.1.2 Software Requirements: 

The software requirements for installing the software can further be grouped into two categories – 
Operating system requirements and MS Excel version requirements. The requirements are as follows: 

2.1.2.1 Operating System Requirements 

Supported operating systems: 

 Windows Vista 

 Windows XP 

 Windows 2003 

 Windows 2000 

2.1.2.2 MS Excel Version Requirements 

Supported MS Excel versions: 
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 MS Excel 2003 

 MS Excel XP 

 MS Excel 2000 

 MS Excel 2002 

 MS Excel 97 

 MS Excel 95 

2.2 Downloading Kernel for Excel for the First Time 

After checking your computer with the prescribed system requirements for Kernel for Excel, you can 
download and install the software on your computer. You can buy the full version of the software from any 
one of our authorized resellers– Element5, Asknet and 2CO. 

If you want to try using Kernel for Excel before buying it, you can download the evaluation version from the 
following link: 

http://www.nucleustechnologies.com/Download-Excel-Worksheet-Repair-Software.php 

 You can repair .xls files saved on your system by using the evaluation version of 
Kernel for Excel; however, the repaired file will display the preview of the 
recovered data but does not allows you to save the repaired file until you 
purchase the full version of the software. 

2.3 Install Kernel for Excel 

After downloading the installer file for Kernel for Excel, you can install the software by running the file. To 
install Kernel for Excel: 

1. Double-click the Kernel for Excel installer. 

2. Follow the on-screen instructions. 

The Setup Installation Complete screen will be displayed. 

3. Click Finish to launch the software. 

2.4 Start Kernel for Excel 

To start Kernel for Excel: 

Click the Start  All Programs Kernel for Excel 

Alternatively, you can launch Kernel for Excel by double-clicking the shortcut icon available on the desktop 
and Quick Launch icon. 

2.5 Uninstall Kernel for Excel 

http://www.nucleustechnologies.com/Download-Excel-Worksheet-Repair-Software.php
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You may need to uninstall and re-install Kernel for Excel. To uninstall Kernel for Excel: 

1. Click the Start  All Programs Kernel for Excel  Uninstall Kernel for Excel 

A warning message will be displayed. 

2. Click Yes to uninstall Kernel for Excel. 

 Before proceeding to uninstall Kernel for Excel, you must ensure that the 
software is not running. 

You can alternatively uninstall Kernel for Excel from the Control Panel by performing the following steps: 

1. Click the Start Menu  Control Panel and then double click the Add or Remove Programs icon. 

2.  Select Kernel for Excel and click Remove. A warning message will be displayed. 

3. Click Yes to uninstall Kernel for Excel. 
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3. Software Interface 

Now that Kernel for Excel has been installed on your computer, you can start using the software after 
getting acquainted with the software interface. 

3.1 Menu-bar 

The menu-bar of Kernel for Excel comprises four main menus – File, Tools, View, and Help. 

3.1.1 File Menu 

The File menu comprises four menu items. 

 

Figure 3.1: File Menu 

Menu items in the File menu: 

Field Name Field Description 

Recovery Select to start the process of recovery after selecting the corrupt 
.xls file 

Multi file Select to view screen of the multiple file repair mode 

Live Update Select to update the older version with the latest version available 
on Nucleus server 

Exit Select to close the software 

3.1.2 Tools Menu 

The Tools menu comprises five menu items. 
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Figure 3.2: Tools Menu 

Menu Items in the Tools menu: 

Field Name Field Description 

Options Select to view screen with four options: Start in 
Single file mode, Start in Multiple file mode, 
Define saving location and Recovered file suffix 

Select Select to browse and select corrupt .xls file for 
repairing 

Repair Select to start the repair process 

Preview Select to view the preview of the repaired file 

Save Select to save the recovered data 

3.1.3 View Menu 

The View menu comprises single menu item 

 

Figure 3.3: View Menu 

 

Menu items in the View menu: 
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Field Name Field Description 

Theme Select to change the software theme 

3.1.4 Help Menu 

The Help menu comprises three menu items. 

 

Figure 3.4: Help Menu 

Menu items in the Help menu: 

Field Name Field Description 

Help Select to view help information pertaining to performing 
various tasks using Kernel for Excel 

Buy Select to visit software buy online page on our website 

About Kernel Recovery for 
Excel… 

Select to view version-related and support information of 
Kernel for Excel 

3.2 Tool-bar 

The tool-bar in Kernel for Excel is displayed below the menu-bar. The tool-bar provides a convenient and 
user-friendly method to perform certain actions that can also be performed by using the menu-bar. Read 
the information in the table below to find out about the tool-bar buttons: 

Button Button Name Button Description 

 

Single-file Select this to view screen of Single file recovery 
mode 
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Multi-file Select this to view screen of Multiple file 
recovery mode 

 

Save file Select this to save the repaired file 

 

Option Select this to view the four options provided in 
the Kernel for Excel software 

 

Live update Select this to update the older version of the 
software with the latest version available on 
Nucleus server 

 

Help Select this to view help information pertaining to 
performing various tasks using Kernel for Excel 

3.3 Status Bar 

Status bar is displayed at the bottom of the software window. The text ‘For Help, press F1’ is displayed on 
the status bar which tells you the command used to access the help files of the software. 

 

Figure 3.5: Status Bar 

3.4 Buttons Used 

Apart from the standard options available in the menu-bar and the tool-bar, two buttons– Select File and 
Recover –are displayed on the main window. 

 

Click to browse and select the .XLS file that needs to be repaired 

 

Click to start the process of repairing 
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Click to remove selected file from the list 

 It is applicable only in case of Multi file mode 

 

Click to remove all the files from the list 

 It is applicable only in case of Multi File mode 

 

Click to skip the saving of selected repaired file 

 

Click to skip the saving of all the repaired file(s) 

 

Click to add files in case of Multi file mode recovery 

 

Click to repair and save the repaired file(s) 

 

Click to apply the settings done in the options screen where four 
options are provided 

 

Click to go back to the previous screen 

 

Click to cancel the operations performed on the screen where four 
options are provided 

 

Click to save the repaired file 

 

Click to stop the saving process 

 Click to browse and select the saving location of repaired file(s) 
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3.5 Customize User Interface 

You can customize the theme of Kernel for Excel by selecting your desired theme from the Theme menu 
item in the View menu. You can add or remove toolbar buttons by clicking: 

 -> Add or Remove Buttons-> Standard in the toolbar and selecting appropriate buttons. 
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4. Repairing .XLS Files 

Now that you have complete familiarity of the user interface of Kernel for Excel, you are ready to repair .xls 
files. To repair .xls files: 

1. Launch Kernel for Excel. 

2. Click the Options button from the tool bar menu. Kernel for Excel provides four different options 
through which you can start the recovery procedure 

 

Figure 4.1: Select Recovery Mode  

3. Select the options (Single file or Multi file) as per requirement and define the settings for the selected 
option and then click the Apply button. 

 You can also cancel the selected option and defined settings by clicking the 
Cancel button. 

 

4.1 Repair Single .XLS File 
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After getting acquainted with the options provided in the Kernel for Excel software, you are ready to repair 
single .xls file. To repair single .xls file: 

1. Select Single File option from the tool bar. 

 

Figure 4.2: Single File Mode  

2. Click the Select File button to browse and select the corrupt .xls file for repairing. 



© N u c l e u s  D a t a  R e c o v e r y . C o m  P r i v a t e  L i m i t e d   

 

Figure 4.3: Select File 

3. Click the Recover button to start the process repairing and recovery. As you click Recover button, 
Kernel for Excel starts the process of repairing corrupt .xls file. 

 Repairing process can be stopped in between by clicking the Stop button 
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Figure 4.4: Recovery Process 

As soon as the Kernel for Excel finishes the repairing process, it displays the complete preview of the 
recovered data of the repaired .xls file before saving. 

4. Click the Save button. After you click Save, the software asks you to define the location to save the 
repaired file. 

 Kernel for Excel asks you to define your priorities to save from the repaired file. 
Select or de-select the checkboxes as per requirement and function 
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Figure 4.5: Save File 

5. Browse to your desired saving location and click the Save button to save the repaired file at the 
defined location. 
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Figure 4.6: Saving Status 

 

As soon as the software finishes the saving process, it displays the link that points to the location where 
the repaired .xls file is saved. 

6. Click the link to view the repaired file or open the repaired file from the saved location. 

 The names of the repaired .xls file will be the original file name suffixed by the 
text which was defined by you in the Recovered file suffix text box. 

4.2 Repair Multiple XLS file(s) 

The Multi file option repairs 100’s of corrupted MS Excel Worksheets in one repair cycle. To start with the 
Multiple file repair process: 

1. Select Multi file option from the tool bar. 
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Figure 4.7:  Multi File Recovery Mode  

2. Click the Add files button to add as many corrupt .xls files for repairing at once. 
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Figure 4.8: Select File  

 

3. Click the Repair and save button to start with the repair and save process. After you click Repair and 
save button, software asks you to define the saving location of the repaired file. 

  You can remove selected file or remove all files from the list by clicking Remove 
files or Remove all files button respectively 

 

Figure 4.9:  Start Repairing Process 

4. Browse to your desired saving location and click Save button. 

 Kernel for Excel asks you to define your priorities to save from the repaired file. 
Select or de-select the checkboxes as per requirement and function. 
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Figure 4.10:  Save File  

 

5. Click Save button to start the saving of the repaired files at the selected location  

 You can skip saving process of all the repaired files or selected repaired files. 
Select Skip All or Skip button to skip the saving of all files or selected files 
respectively. 

As soon as the Kernel for Excel finishes the repairing and saving process, it displays the message 
‘repairing done’. 
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Figure 4.11:  Repairing Process Completed 

6. Click the link to view the repaired files. 

 The names of the repaired .xls files will be the original file name suffixed by the 
text which was defined by you in the Recovered file suffix text box. 
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5. Full Version 

Although you can use Kernel for Excel evaluation version for free and experience the capabilities of the 
software, there are certain features that are not available in the evaluation version. 

5.1 Requirement of Full Version 

By using the evaluation version of Kernel for Excel, you can repair corrupt .xls files; however, you cannot 
save the contents of the repaired files. You can only view the preview of the recovered data. 

You will need to buy the full version of the software to save the recovered data of the repaired file. 

5.2 Purchasing Full Version 

You can buy the full version of Kernel for Excel from any one of our authorized resellers – Element5, 
Asknet and 2CO. 

As soon the purchase transaction with our resellers gets completed, our sales team will send you an email 
comprising the URL to download the full version of Kernel for Excel and activation details of the software. 
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6. Support 

We have an extensive and efficient support system in place to assist our customers with all issues related 
to using Kernel for Excel. The software comes with an embedded help manual that can be accessed by 
clicking HelpSoftware Help in the menu-bar. You can also press the F1 key on the keyboard of your 
computer to access the embedded help of Kernel for Excel. 

You can access the online help for Kernel for Excel at http://www.nucleustechnologies.com/Online-
Helps.html 

View Animated Working demo of the software at 

http://www.nucleustechnologies.com/excel/animatedexcel.html 

We also have live support wherein you can chat with our software experts at 
http://www.nucleustechnologies.com/Support.html 

To talk on phone with our software experts call: 

Help line:  
 

+91-9818725861 

1-866-348-7872 (Toll Free for USA/CANADA) 

You can also email us about your queries at; 

sales@nucleustechnologies.com for Sales 

support@nucleustechnologies.com for Support 

contact@nucleustechnologies.com for General Queries 

  

http://www.nucleustechnologies.com/Online-Helps.html
http://www.nucleustechnologies.com/Online-Helps.html
http://www.nucleustechnologies.com/excel/animatedexcel.html
http://www.nucleustechnologies.com/Support.html
mailto:sales@nucleustechnologies.com
mailto:support@nucleustechnologies.com
mailto:contact@nucleustechnologies.com
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7. Troubleshooting 

This section deals with your generic and specific queries pertaining to using Kernel for Excel. 

7.1 Common Issues 

Why does Kernel for Excel have limitations in evaluation copy? 

The free evaluation version of Kernel for Excel is intended to enable you to experience the capabilities of 
the software. You will need to buy the software to save the recovered data of the repaired file. 

7.2 Frequently Asked Questions 

How to Buy Kernel for Excel? 

You can buy Kernel for Excel online at http://www.nucleustechnologies.com/Buy-Excel-Worksheet-Repair-
Software.php 

I have lost my full version for Kernel for Excel. Can you help me? 

Please email us at sales@nucleustechnologies.com. Please include your name, address, email address, 
and order confirmation number (if you have it). We will be happy to help you. 

Would I get an invoice for my purchase? 

Yes, we provide every customer with a soft copy of the invoice. This is sent on the same day, on your 
email. 

I am unable to view any data in the excel file preview sheet, what to do?  

After successful file repair of the corrupt .xls file, Kernel for Excel will display the file preview but in many 
cases the data is present in Sheet1 and in the preview you may see the active sheet as Sheet3, so Select 
Sheet1 and you may see your data there. 

Preview feature is only available in single file repair process. If you are repairing multiple files in one repair 
cycle, you will not be able to view the preview of the recovered file(s) as the Multi file option does not 
support preview feature.  

http://www.nucleustechnologies.com/Buy-Excel-Worksheet-Repair-Software.php
http://www.nucleustechnologies.com/Buy-Excel-Worksheet-Repair-Software.php
mailto:sales@nucleustechnologies.com
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8. Legal Notices 

This section comprises the legal specification about Kernel for Excel and the company NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED 

8.1 Copyright 

NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, Nucleus Kernel accompanied user manual and 
documentation are copyright of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED, with all rights 
reserved. Under the copyright laws, this user manual cannot be reproduced in any form without the prior 
written permission of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. No Patent Liability is 
assumed, however, with respect to the use of the information contained herein. 

© NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. All rights reserved. 

8.2 Trademark 

Nucleus Kernel ® is a copyright work of NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

Windows 95®, Windows 98®, Windows ME®, Windows NT®, Windows 2000 Server®, Windows 2000 
Advanced Server®, Windows 2003 Server®, Windows XP®, Windows Vista, MS-DOS and MS Office are 
registered trademarks of Microsoft Corporation. 

All other brand and product names are trademarks or registered trademarks of their respective companies. 

8.3 Disclaimer 

The Information contained in this manual, including but not limited to any product specifications, is subject 
to change without notice. NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED provides no warranty 
with regard to this manual or any other information contained herein and here by expressly disclaims any 
implied warranties of merchantability or fitness for any particular purpose with regard to any of the 
foregoing NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED assumes no liability for any damages 
incurred directly or indirectly from any technical or typographical errors or omissions contained herein or 
for discrepancies between the product and the manual. In no event shall NUCLEUS DATA 
RECOVERY.COM PRIVATE LIMITED, be liable for any incidental, consequential special, or exemplary 
damages, whether based on tort, contract or otherwise, arising out of or in connection with this manual or 
any other information contained herein or the use there of. 

8.4 License Agreement 

Kernel for Excel Copyright © by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 

Your Agreement to this License 

You should carefully read the following terms and conditions before using, installing or distributing this 
software, unless you have a different license agreement signed by NUCLEUS DATA RECOVERY.COM 
PRIVATE LIMITED. The terms and conditions of this License describe the permitted use and users of 
each Licensed Copy of Kernel for Excel. For purposes of this License, if you have a valid license, you 
have the right to use a single Licensed Copy of Nucleus Kernel. 
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Scope of License 

Each Licensed Copy of Kernel for Excel may either be used by a single person or used non-
simultaneously by multiple people who use the software personally installed on a single workstation. All 
rights of any kind in Nucleus Kernel, which are not expressly granted in this License, are entirely and 
exclusively reserved to and by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED. You may not rent, 
lease, modify, translate, reverse engineer, decompile, disassemble, or create derivative works based on, 
Nucleus Kernel, nor permit anyone else to do so. You may not make access to Nucleus Kernel available 
to others in connection with a service bureau, application service provider, or similar business, nor permit 
anyone else to do so. 

Warranty Disclaimers and Liability Limitations 

Kernel for Excel, and any and all accompanying software, files, data and materials, are distributed and 
provided AS IS and with no warranties of any kind, whether expressed or implied. In particular, there is no 
warranty for the quality of data recovered. You acknowledge that good data processing procedure dictates 
that any program, including Nucleus Kernel, must be thoroughly tested with non-critical data before there 
is any reliance on it, and you hereby assume the entire risk of all use of the copies of Nucleus Kernel 
covered by this License. This disclaimer of warranty constitutes an essential part of this License. In 
addition, in no event does NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED authorize you or 
anyone else to use Kernel for Excel in applications or systems where Kernel for Excel failure to perform 
can reasonably be expected to result in a significant physical injury, or in loss of life. Any such use is 
entirely at your own risk, and you agree to hold NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED 
harmless from any and all claims or losses relating to such unauthorized use. 

General 

This License is the complete statement of the agreement between the parties on the subject matter, and 
merges and supersedes all other or prior understandings, purchase orders, agreements and 
arrangements. This License shall be governed by the laws of the State of Delhi. Exclusive jurisdiction and 
venue for all matters relating to this License shall be in courts and for a located in the State of Delhi, and 
you consent to such jurisdiction and venue. There are no third party beneficiaries of any promises, 
obligations or representations made by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED herein. 

Any waiver by NUCLEUS DATA RECOVERY.COM PRIVATE LIMITED of any violation of this License by 
you shall not constitute, nor contribute to, a waiver by NUCLEUS DATA RECOVERY.COM PRIVATE 
LIMITED of any other or future violation of the same provision, or any other provision, of this License. 


